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1. Обзор  
 

Благодарим Вас за загрузку Программного Обеспечения RTS Tools.  

RTS Tools (RS Terminal Software Tools) является приложением Windows, которое записывает 

данные, полученные с электронных весов производства SHINKO DENSHI, на компьютер под 

управлением ОС Windows. RTS Tools состоит из двух отдельных программных инструментов: 

RTSLogTool и RTSInputTool.  

  

RTSLogTool  

Этот инструмент предназначен для записи полученных с весов данных на компьютер 

под управлением ОС Windows в виде текстовых (.txt) файлов или файлов формата  CSV. 

Данные, импортированные в RTSLogTool, автоматически сохраняются в файл. Также имеется 

возможность отправлять команды на весы.  

 

RTSInputTool  

Этот инструмент предназначен для записи данных, полученных с весов, 

непосредственно в приложения Windows (Microsoft Excel, и т.п.)  
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2. Замечания  
 

· Перед началом использования инструментов RTS Tools рекомендуется на всякий случай 

сохранить важные данные на компьютере под управлением  ОС Windows.    

· По вопросам работы с коммерческими программными продуктами для Windows иными, 

чем RTS Tools, пожалуйста, консультируйтесь с их производителями.  

· RTS Tools не предназначен для официального коммерческого использования.  

· Авторские права на этот документ принадлежат SHINKO DENSHI CO., LTD. Полное или 

частичное копирование или перепечатка содержимого этого документа без официального 

одобрения правообладателя запрещаются.  

· Содержимое этого Руководства может быть изменено без предварительного 
уведомления..  

· Microsoft, Windows, Excel и Word являются зарегистрированными торговыми марками 

или наименованиями Microsoft Corporation в США и других странах.  

· Наименование и логотип Bluetooth® являются зарегистрированными торговыми марками 

Bluetooth SIG, Inc., и любое их использование SHINKO DENSHI CO., LTD. 

лицензировано. Иные торговые марки и наименования являются собственностью их 

уважаемых владельцев.  
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3. Лицензионное соглашение  
 

· Неавторизованное копирование RTS Tools запрещено.    

· Спецификации RTS Tools могут быть изменены без предварительного уведомления.  

· SHINKO DENSHI Co., Ltd. имеет все авторские права на RTS Tools.  

· RTS Tools можно использовать для сохранения данных с электронных весов 

производства SHINKO DENSHI на компьютер под управлением ОС Windows.    

· RTS Tools можно устанавливать и использовать только на жёстком диске или ином 

устройстве памяти Windows-компьютера, присоединённого к весам.  

· SHINKO DENSHI CO., LTD. не берёт на себя ответственности за любые прямые или 

косвенные, очевидные или подразумеваемые повреждения, произошедшие по 

причине дефектов RTS Tools или ошибок в этой документации, даже если им будет 

заранее известно о потенциальной возможности таких повреждений. В дополнение, мы 

не откликаемся на претензии третьих лиц в отношении прав. Также, мы не берём на 

себя ответственности за любые повреждения программ и потерю данных.  

 

 

Июль 1, 2020  

SHINKO DENSHI CO., LTD.  
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4. Подготовка к работе  

 

4.1  Оборудование  

 
Электронные весы  
 
Требуются электронные весы производства SHINKO DENSHI с интерфейсом RS-232C, USB, 
или Bluetooth.  

 
Компьютер  

Требуется следующая конфигурация: 
 

Объект Состояние 

Поддерживая ОС Windows 10 (64bit) 

.NET Framework Версия 4.6 или выше 

Разрешение монитора XGA (1024×768 Pixel) или выше. 

 

Замечание  
 

Если размер изображения будет установлен в значение иное, чем 100%, могут возникнуть 
следующие трудности.  

· Изображение на экране может быть искажено.  

· Символы на экране могут иметь разрывы.  

 
Приложение  

При использовании инструмента RTSInputTool, самостоятельно подготовьте 

приложение для приёма данных, такое как Microsoft Excel. 

 
Кабель  

Перекрёстный нуль-модемный кабель требуется для соединения между весами и 

портом RS-232C на Вашем Windows-компьютере.  

Для детальных подробностей, таких как диаграмма контактов, обращайтесь к 

сопроводительной документации на приобретённое Вами оборудование.  
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4.2  Соединение  

 
 

Соединение между весами и компьютером  (RS-232C, USB)  
 

Шаг 1. Выбор COM-порта.  
 

Присоедините заранее приготовленный кабель к компьютеру и выберите 

соответствующий COM-порт на стороне компьютера.  

 

Шаг 2. Кабельные соединения  
 

Присоедините к весам второй конец кабеля.  

 
Замечание:  

 

Если соединение производится через интерфейс USB, потребуется установка на 

компьютер USB-драйвера. Для подробностей обращайтесь, пожалуйста, к 

документации на приобретённое Вами оборудование.  

 
Присоединение весов к компьютеру через Bluetooth.  

Пожалуйста, обращайтесь к документации на приобретённое Вами компьютерное 

и весовое оборудование для соединения его между собой по Bluetooth.  

 
Установки на весах  

Для подробностей обращайтесь пожалуйста к разделу передачи данных в 

документации на Ваше весовое оборудование.  
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5. Программа RTSLogTool  

 

5.1  Описание программы RTSLogTool  

 
 

Функциональные возможности  

· Вы можете управлять весами, посылая на них команды с компьютера.  

· Данные могут передаваться и приниматься между компьютером и весами.  

· Переданные и полученные данные могут отображаться на мониторе компьютера и 

сохраняться в текстовые (txt) и CSV-файлы.    

· Принятые данные автоматически сохраняются в файл.  

· Передаваемые и принимаемые файлы могут быть распечатаны на принтере, 
подключенном к компьютеру.  

· Коммуникация может быть установлена одновременно с несколькими весами, 

подключенными к компьютеру.  

· Программа может выполняться одновременно с другими приложениями.  

· С весов могут приниматься данные в формате GLP.  
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5.2  Предназначение каждой части программы RTSLogTool.  

 
Данная программа состоит из четырех основных блоков.  

 

1 Блок коммуникационных настроек.  

Здесь задаются параметры канала передачи данных.  
 

2 Блок приёма данных.  

Здесь устанавливаются параметры приёма данных.  
 

3 Блок установок передачи команд.  

Здесь задаются параметры управляющих команд.  
 

4 Блок журнала передачи и приёма.  

Этот блок используется для управления журналом команд.  
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5.3  Как работать с программой.  

5.3.1  Запуск / Закрытие  

программы.  

Шаг 1 Запуск программы  RTSLogTool  

Запуск через меню “Start” (Пуск) окна Windows.  

Порядок запуска: "Start"->"Programs"->"RTS Tools"->"RTS Log Tool".  

  

  

  

  

  

  

  

  

  
 

 
 
 
 
 
Шаг  2  Выбор языка  

Select Menu → Language → “English” (для выбора Английского языка).  

 
Шаг  3  Коммуникационные установки.  

Установите каждый параметр в соответствии с установками, сделанными на весах. 

Подробное описание установок смотрите в разделе "5.4 Описание установок".  

 

Замечание  

· Если присоединяются несколько весов, не выбирайте для них один и тот же порт.  

Шаг 4 Закрытие программы  RTSLogTool   

Select Menu → File → Exit для закрытия RTSLogTool.     

5.3.2  Запуск / Закрытие журнала  

 
Шаг 1 Запуск журнала  

 

Кликните на кнопке [Start].  
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Выберите папку и имя файла для сохранения данных, и нажмите Save.  

Место и название папки, в которой будет сохранён файл с данными, отобразится в поле 

[File storage path]. Кнопка [Start] станет недоступной (серый цвет), и передача данных 

станет возможна.  

  

  
  
Шаг  2  Передача данных с весов  

Данные передаются с весов.  

 
Шаг 3  Просмотр принятых данных  

Убедитесь, что показания массы с весов отображаются в поле [Latest data received].  

Если показания массы не отображаются, смотрите раздел “8. Возможные проблемы и их 
решения”. Принятые данные будут отображаться в поле [Log data].  

Принятые данные также автоматически будут записываться в файл.  
 
Шаг  4  Передача команд 

Выберите нужную команду в поле списка [Send command] и щелкните на кнопке [Send] 
для передачи команды на весы.  

 
Шаг 5  Завершение журналирования  

Щёлкните на кнопке [End Log] для завершения обмена данными с весами. 
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5.4  Описание параметров  
 
1 Секция [Communication settings] (Параметры обмена данными).  

 
Установки параметров обмена данными на весах и в программе RTSLogTool 
должны соответствовать друг другу. 
 

Параметр Значение, отображаемое на дисплее 

Port  number COM-порт распознаётся автоматически ОС Windows 

Baud rate (Скорость 

передачи данных) 

1200・2400・4800・9600・19200・38400・57600・115200 

(Единицы измерения bps (бит в секунду)). 

Parity (Проверка чётности) None / Odd / Even 

Data bit (Размер данных) 7・8 (Единицы измерения – bit) 

Stop bit (Стоповые биты) 1・2 (Единицы измерения – bit). 

Terminator (управляющий 

символ конца строки) 
CR / LF・CR 

 
2    Секция [Receive data processing]  (Обработка принятых данных).  

 
Формат принимаемых данных.  

 
Format (Используемый формат)  

Устанавливает формат в соответствии с установками на весах.  

· 6-8 digit. 

Выбирается соответственно установке на весах, когда на них установлен 6-

значный цифровой формат, 7-значный цифровой формат или 8-значный 

цифровой формат.    

· CBM  

Выбирается когда на весах установлен режим передачи данных в формате CBM.    

· Others  

Выбирается когда данные передаются в формате GLP.    

Выбирается при использовании формата, иного чем 6-8 digit и CBM.    

 

При выборе этого формата, некоторые функции могут быть ограничены.   
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Stop position  
 

· Если поле отмечено галочкой, разделитель данных будет вставляться при 

журналировании.    

· Выбирает вид разделителя – comma (запятая), space (пробел) или tab (табулятор).    

· Если для формата было выбрано значение [Other], разделитель использовать нельзя.    

 
Output CSV header  

 

· Если поле отмечено галочкой, при старте журналирования будет вставлен заголовок CSV.    

 
Composition  

 

· Выбор формы вывода данных журнала: ASCII (алфавитно-цифровая) или HEX 
(шестнадцатиричная).    

 
Additional  

 

  Установка дополнительных данных, добавляемых к данным, поступающим от весов.  
 

· Number: Если поле отмечено галочкой, порядковый номер будет добавляться в журнал 
перед данными, поступающими с весов.    

· Date: Если поле отмечено галочкой, текущая дата будет добавляться после данных, 
поступающих с весов.    

· Time: Если поле отмечено галочкой, текущее время будет добавляться после данных, 
поступающих с весов, и после даты, если отмечено также поле [Date].    

 
Plus sign as a blank  

 

· Если поле отмечено галочкой, знак “ + “ для обозначения положительных данных в 
журнале будет опущен.    

· Если в поле [Format] было выбрано значение [Other], знак “ + “  не может быть опущен.    

 
Beep when receiving  

 

· Когда поле отмечено галочкой, при приёме данных компьютер будет выдавать 
подтверждающий звуковой сигнал.    

· В зависимости от конструкции компьютера и наличия динамиков, звуковой сигнал может 
быть не слышен или слышен только в наушниках, подключаемых к компьютеру.    
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３ Секция [Send command settings] (Передача внешних команд на весы)  

 
Поле [Send Command]  

· Выпадающий список команд для передачи на весы.    

· Команда выбирается из списка доступных.    

· Команды, отсутствующие в списке, можно передать путём непосредственного 

ввода в поле [Send command].    

· Когда команда выбирается из списка, описание выполняемых ей действий 

появляется непосредственно ниже поля ввода команды.    

· Список команд, воспринимаемых конкретной моделью весов, можно найти в 

Руководстве по Эксплуатации от этих весов.    

 
Кнопка [Send]  

 

· Отправляет на весы команду, выбранную или заданную в поле  [Send command].    

 
Автоматическая передача команд  

 

· Auto send every: Если поле отмечено галочкой, команда будет передаваться автоматически 
через заданные промежутки времени.    

· Промежуток времени для автоматической передачи команд задаётся в секундах.    

· Устанавливайте значение от 5 секунд и более.    

 
Замечание:  

 

· Если поле [Auto send every] не отмечено галочкой, для каждой передачи команды 
необходимо нажимать кнопку [Send].    

· Если требуется получение данных каждую секунду или чаще, установите на 

весах в настройках непрерывную передачу данных.  

· Для получения информации об интервале при непрерывной передаче данных, 

обращайтесь к Руководству по Эксплуатации от используемых весов.    

 
 Автоматическая остановка передачи команд 

 

· Auto stop:  Если поле отмечено галочкой, функция автоматической передачи команд через 

заданные промежутки времени будет автоматически отключена через заданное время.    

· Время может быть задано в минутах.    

· Устанавливайте значения более 1 минуты.    

 
Log display of send command:  

 

· Если поле отмечено галочкой, передаваемая команда будет отображаться в журнале.    
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４  Секция [Log management] (Управление журналированием данных).  

 
File storage path  

 

· Поле отображения пути к сохраняемому файлу данных журнала и имя файла.  
 

Кнопка [Refer]  
 

· Открывает папку, заданную для сохранения файла с данными журнала.  

 
Latest data received 

 

· Здесь отображается строка последних принятых данных.  

 
Log Data  

 

· Отображает окно журнала принимаемых данных.  

· Размер поля окна журнала автоматически увеличивается при увеличении окна программы 
(перетаскиванием мышью его границ).  

· Вы можете просматривать ранее принятые данные при помощи поля прокрутки справа.  

 
Кнопка [Start]  

 

· Открывает порт и запускает обмен данными.  

 
Кнопка [Stop]  

 

· Останавливает обмен данными.  

 
Кнопка [Clear]  

 

· Очищает окно журнала [Log data].  

 
Кнопка [Print]  

 

· Печатает содержимое журнала на принтере, подключенном к компьютеру.  
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6. Программа  RTSInputTool  

 
6.1 Предназначение программы  RTSInputTool  

 

Возможности  

· Результаты измерений с весов могут быть переданы непосредственно в 
приложения, такие как Microsoft Excel.  

· Результаты измерений с весов могут быть вставлены в приложение Windows 
так же, как если бы они были введены с клавиатуры.  

· Тип приложения, в которое передаются данные, не имеет значение.  

· От весов могут быть также приняты данные в формате GLP.  

 
Замечание:  

· При использовании Microsoft Excel, пожалуйста используйте текстовой формат данных для 
ячеек, в которые планируется передавать данные измерений.  

  

6.2 Описание секций главного окна программы RTSInputTool 

 
Окно программы RTSInputTool состоит из трёх основных секций.    

1 Communication settings  

В этой секции устанавливаются параметры канала передачи данных.  

2 Application  

В этой секции устанавливается метод ввода данных в приложение и запуск.  

3 Receive data processing  

В этой секции происходит обработка и форматирование принятых данных.  
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6.3 Работа с программой RTSInputTool 

6.3.1 Запуск / закрытие программы 

6.3.2 Шаг 1  Запуск Программы RTSInputTool. 
 
Программа запускается из меню «Пуск» рабочего стола Windows.  
 
Порядок запуска: "Пуск" -> "Программы" -> "RTS Tools" -> "RTS Input Tool". 
  

  

  

  

  

  

  

  

  

  

 
 
 
 
 
 
Шаг  2  Выбор языка 

Основное меню → Language → English / Japan.  

 
Шаг  3  Установки порта RS-232C  

Каждый коммуникационный параметр в программе RTSInputTool должен 

соответствовать параметру, установленному на весах.  

Подробное описание параметров приводится в разделе  "6.4 Описание параметров".  

 
Шаг  4  Закрытие программы RTSInputTool.  

Основное меню → File → Exit (для выхода из программы RTSInputTool).  
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6.3.3 Процесс работы с программой RTSInputTool.  

 
Шаг  1  Использование внешнего дисплея  

Нажмите экранную кнопку [External display] для отображения внешнего дисплея.  

 
Шаг  2 Получение данных с весов  

Данные передаются с весов в программу RTSInputTool.  

 
Step 3 Проверка получения данных  

Убедитесь, что результаты измерений отображаются на внешнем дисплее. Если этого не 

происходит, обращайтесь к разделу “8. Проблемы и их решение”. Размер внешнего дисплея 

можно менять простым перетаскиванием его границ при помощи мыши. 

  

  

  

  

 
 
 
 
Шаг  4  Закрытие внешнего дисплея.  

Щёлкните в поле [x] окна внешнего дисплея для его закрытия.  

 
Шаг  5  Запуск внешнего приложения  

Запустите приложение (такое как Microsoft Excel), в которое собираетесь передавать 
данные с весов.  

 
Шаг  6  Установка функции ввода на компьютере.  

Установите непосредственный ввод, если включен какой-то другой тип ввода данных..  
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Шаг  7 Установка позиции вывода данных 

Переместите курсор туда, куда собираетесь выводить данные с весов. 

Если используется Microsoft Excel, выберите нужную ячейку.  

 
Шаг  8 Начало вывода данных  

Нажмите экранную кнопку [Data input].  

Главное окно программы RTSInputTool будет свёрнуто, а данные с весов будут готовы к 

передаче непосредственно в приложение Windows в позицию курсора.  

 
Шаг  9  Вывод данных в приложение Windows  

Начните передачу данных с весов в согласии с установками, сделанными на весах. 

(Например, если на весах установлена передача данных по нажатию кнопки “Print” при 

условии стабилизации, дождитесь стабилизации и нажмите кнопку “Print”). Данные будут 

переданы в приложение и отобразятся в позиции курсора.  

  

  

  

  

  

  

  

 
 
 
 
 
Шаг  10 Завершение сеанса вывода данных. 

Щелкните на значке программы RTS Input Tool в панели задач. Передача данных будет 

остановлена и на экране вновь отобразится главное окно программы RTSInputTool.  
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Примечания  
 

· RTSInputTool преобразует данные в кодировку клавиатуры и посылает их в приложение. 

Если Вы перемещаете курсор ввода в новое место во время сеанса передачи, данные 

будут передаваться в новое место курсора. Поэтому не перемещайте курсор ввода в 

процессе получения данных с весов.  

· По вопросам работы приложений Windows, в которые Вы собираетесь передавать 

данные, пожалуйста, обращайтесь к их производителям.  

· Порядок, в котором запускаются программа RTSInputTool и приложение Windows не 

имеет никакого значения.  

· Передача данных возможна только тогда, когда главное окно программы RTSInputTool 

свёрнуто до значка в панели задач.  

· Чтобы принять данные в приложение Windows, когда основное окно программы 

RTSInputTool свёрнуто, расположите курсор ввода в приложении в том месте, куда 

хотите получить данные с весов  

· Если ввод с клавиатуры и мыши не работает, остановите передачу данных с весов и 

подождите, пока данные на мониторе не обновятся. Остановите интерфейс передачи 

данных в программе, кликнув на значке программы RTSInputTool в панели задач, а 

затем регулируйте период автоматического приёма показаний и передачи на весах.  

· Когда данные принимаются в программу Microsoft Excel с одновременным рисованием 

диаграмм в реальном времени, обработка данных в Microsoft Excel может занимать 

больше времени, чем скорость поступления новых данных, из-за чего вывод данных 

может стать некорректным.  
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6.4  Описание параметров  
 
1   Секция [Communication settings] (Параметры обмена данными).  

 
Установки параметров обмена данными на весах и в программе RTSInputTool 
должны соответствовать друг другу. 
 

Параметр Значение, отображаемое на дисплее 

Port  number COM-порт распознаётся автоматически ОС Windows 

Baud rate (Скорость 

передачи данных) 

1200・2400・4800・9600・19200・38400・57600・115200 

(Единицы измерения bps (бит в секунду)). 

Parity (Проверка чётности) None / Odd / Even 

Data bit (Размер данных) 7・8 (Единицы измерения – bit) 

Stop bit (Стоповые биты) 1・2 (Единицы измерения – bit). 

Terminator (управляющий 

символ конца строки) 
CR / LF・CR 

 
2 Приложение  

 
Метод ввода данных  

 

Устанавливает обработку данных после получения.  

· Auto  

Вставляется символ табуляции между поступившими данными и дополнительной 
информацией, добавляемой к ним, и символ перевода строки (аналогично клавише 
Enter) по окончанию приёма данных.  

· Enter  

Вставляется символ Enter после данных и дополнительной информации.    

· Tab  

Вставляется символ Tab после данных и дополнительной информации. 
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 Кнопка [External Display]  

· Внешний дисплей удобен для тестирования поступления данных с весов.  

· Если при отправке данных с весов они отображаются на внешнем дисплее, значит 

передача данных настроена правильно.  

· Размер внешнего дисплея может быть изменён. Размер шрифта отображаемых на 

нём данных при этом автоматически тоже будет соответственно меняться.  

 

Кнопка [Data input]  

· Свёртывает главное окно программы RTSInputTool и открывает канал связи для приёма 

данных с весов.  

· Когда данные поступают с весов, они автоматически выводятся в приложение Windows 

в позицию курсора ввода.  

· Чтобы остановить передачу данных, щёлкните на значке RTS Input Tool в панели задач.  

· Когда канал связи будет закрыт, на дисплее снова отобразится главное окно программы.  

 

3 Секция [Receive data processing].    
 

Format  

Здесь выбирается формат принимаемых с весов данных.  

  

· 6-8 digit 

Выбирайте его, когда весы передают данные в 6-значном, 7-значном или 8-значном 
цифровом коммуникационном формате.  

  

· CBM  

Выбирайте его, когда весы передают данные в коммуникационном формате CBM. 

  

· Other  

Выбирайте его, когда весы передают данные в формате GLP.  

Выбирайте его, когда данные передаются в ином формате (кроме 6-8 digit и CBM. При 

выборе этого формата, некоторые функции будут ограничены.  
  

Decimal point (десятичный знак – точка или запятая).  

· Десятичные знаки при выводе данных могут отделяться либо точкой (.), либо запятой (,). 

· Если для формата выбрано значение [Other], выбор этой опции будет недоступен.  
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· При использовании функции интервала в RTS, на весах должна быть установлена 

непрерывная передача данных.  

Stop position  
 

· Если поле отмечено галочкой, полученные данные при выводе будут отделяться друг от 

друга выбранным способом.  

· Выберите тип разделителя из выпадающего списка (“Comma”- запятая, “Space” -

пробел, “Tab” - табуляция).  

· Если в поле [Format] было выбрано значение “Other”, выбор разделителя будет 

недоступен.  

  

Delete (/[]) for auxiliary readability  

· Когда это поле отмечено галочкой, при выводе знак отделения дополнительного 

интервала не будет выводиться.  

· Если в поле [Format] было выбрано значение “Other”, отключение отображения 

разделителя дополнительного интервала будет недоступно.  

 
Additional data  

 

· Устанавливает, какие дополнительные данные будут добавляться к данным, 

поступающим с весов, при выводе.  

· Если отмечено галочкой поле “Number” перед полученными данными будет выводиться 

порядковый номер.  

· Если отмечено галочкой поле “Date”, текущая дата будет добавляться при выводе после 

полученных данных.  

· Если отмечено галочкой поле “Time”, текущее время будет добавляться при выводе 

после полученных данных (и даты, если было выбрано также поле “Date”). 

 
Plus sign as a blank  

 

· Если поле отмечено галочкой, знак + в полученных данных будет заменен пробелом.  

· Если в поле [Format] было выбрано значение “Other”, знак + заменить будет нельзя.  

 
Interval timer  

 

· Если это поле отмечено галочкой, можно будет задать интервал приёма данных.  

 
Beep when received  

 

· Если поле отмечено галочкой, приём данных будет подтверждаться звуковым сигналом.  

· В зависимости от конфигурации и настроек ПК, звуковой сигнал может не звучать.  
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7. Примеры  использования  инструментов  RTS 

 
Этот раздел описывает примеры применения Инструментов RTS и необходимые 

настройки на весах. Как делать необходимые настройки для каждой модели весов,  

описано в Руководстве по Эксплуатации, прилагаемом к весам. 

  

 

7.1 Передача значений массы в Excel  

 
· Запустите Microsoft Excel.  

· Запустите RTSInputTool. Установите параметры RTSInputTool как в таблице ниже.  

 

 

Параметр RTSInputTool Значение 

Format 
6-8 digit  или  CBM 

(В соответствии с установкой на весах) 

Stop position 
Отметить галочкой 

Выбрать разделитель “Tab” (табуляция) 

 

· Нажмите кнопку [Data input] для перемещения курсора ввода в Microsoft Excel.  

· Значение массы будет принято от весов и передано в Microsoft Excel.  

· Рассчитывайте суммарную массу, максимум, минимум, среднее, стандартное 

отклонение и т.д. входных данных посредством функций Microsoft Excel.  

 

Установка на весах По нажатию клавиши при условии стабилизации 

Используемый Инструмент RTS RTSInputTool 

Используемое Приложение Microsoft Excel 
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7.2 Печать и сохранение результатов калибровки.  

 
· Запустите программу RTSLogTool и включите передачу данных.  

· Результаты калибровки будут получены с весов и автоматически сохранятся в 

файл.  

· Нажмите экранную кнопку [Print] окна RTSLogTool для печати на принтер, 

подключенный к Вашему компьютеру. 

 

Установки на весах Включена передача данных отчета калибровки. 

Используемый Инструмент RTSLogTool 

Используемое Приложение Нет 

 

 

  

 

 

7.3 Автоматический импорт результатов измерений в Excel.  

 
· Установите настройки передачи Ваших весов на автоматическую однократную 

передачу при наступлении стабилизации.  

· Запустите Microsoft Excel.  

· Запустите программу RTSInputTool и нажмите в ней экранную кнопку [Data input] 

для перемещения курсора ввода в Microsoft Excel.  

· Расположите взвешиваемый предмет на платформе весов. Полученное 

значение массы передастся с весов в программу Microsoft Excel.  

 

Установки на весах Однократный вывод при наступлении стабилизации 

Используемый инструмент RTSInputTool 

Используемое приложение Microsoft Excel 
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7.4 Просмотр результатов измерений на большом экране.  

 
· Запустите программу RTSInputTool и нажмите экранную кнопку [External Display].  

· Увеличьте окно внешнего дисплея до нужного размера, перетаскивая его границы.  

· Измеренное значение с весов отобразится в окне внешнего дисплея.  

 

 

Установки на весах Непрерывная безусловная передача данных 

Используемый инструмент RTSInputTool 

Используемое приложение Нет 
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7.5 Импорт результатов подсчёта в Excel  

 
· Установите весы в счётный режим.  

· Запустите Microsoft Excel.  

· Запустите программу RTSInputTool и нажмите в ней экранную кнопку [Data input] 

для перемещения курсора в Microsoft Excel.  

· Расположите подсчитываемые образцы на платформе весов и результат 

подсчёта (количество) будет передан в Microsoft Excel.  

· Используйте функции Microsoft Excel для выполнения операций над поступившими с весов 

значениями. 

 

Установки на весах Счётный режим 

Используемый инструмент RTSInputTool 

Используемое приложение Microsoft Excel 

 
 
 
  

 

7.6 Масса животного  

 
· Установите весы в режим взвешивания животных.  

· Запустите Microsoft Excel.  

· Запустите программу RTSInputTool и нажмите экранную кнопку [Data input] для 

перемещения курсора в Microsoft Excel.  

· Расположите животное на платформе весов (или в специальной таре) и 

осуществите передачу данных с весов. Данные отобразятся в Microsoft Excel.  

· Используйте функции Microsoft Excel для необходимой обработки полученных данных. 
 
 
  

Установки на весах Режим взвешивания животных 

Используемый инструмент RTSInputTool 

Используемое приложение Microsoft Excel 
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8. Проблемы и их решения  

 
8.1 Невозможно сохранить данные с весов на компьютер.  

 
Если не получается сохранить данные с весов на компьютер при помощи 

инструментов RTSLogTool и RTSLogTool, проверьте пункты в таблице ниже. 

По возможности, не используйте одновременно никакие другие программы (приложения).  

 
 

Проверка  соединения  
 

Возможная причина Решение проблемы 

Проверьте тип, распайку и исправность 
применяемого кабеля (RS- 232C/USB). 

Проверьте по инструкции к Вашим весам 
тип необходимого кабеля. 

Проверьте правильность и надёжность 
соединения весов с компьютером. 

Корректно соедините кабель с весами 
согласно инструкции. 

Проверьте правильность установки USB-
драйвера (если применяется USB-
соединение) 

При соединении через USB, требуется 
USB-драйвер. Подробности смотрите в 
инструкции от весов или кабеля-адаптера 
USB-COM. 

Не был ли кабель отключен во время 
работы? 

Если кабель был отключен во время 
работы программы, недостаточно его 
просто снова подключить. Сперва надо 
завершить работу программы. 

Проверьте соединение в случае 
использования Bluetooth. 

При использовании соединения Bluetooth, 
необходимо предварительное спаривание 
устройств. Смотрите инструкцию к Вашим 
весам для подробностей. 
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Проверка настроек соединения  
 

Возможная причина Решение проблемы 

Соответствуют ли настройки передачи 
данных на весах и в программе RTS 
(кроме портов)? 

Параметры передачи и приёма данных на 
весах и в программе RTS должны быть 
согласованы (одинаковы). 

Правильно ли выбран COM-порт в 
программе RTS? Соответствует ли он 
порту, к которому подключены весы? 

Выберите в программе тот COM-порт, к 
которому подключены весы. Перед 
изменением COM-порта в настройках, 
остановите передачу данных. 

Не менялись ли параметры настройки в 
процессе работы программы RTS? 

Если параметры настройки передачи 
менялись в процессе работы программы 
RTS, закройте программу и запустите её 
заново с нужными параметрами. 

 
 
 

Проверка передачи данных с весов 
 
  

Возможная причина Решение проблемы 

Передаются ли данные с весов? 
Проверьте по инструкции от весов, 
включена ли и правильно ли настроена по 
меню функций передача данных. 

Используются ли весы производства 
Shinko Denshi? 

Пожалуйста, используйте только весы 
производства Shinko Denshi. Работа 
программных инструментов RTS не может 
быть гарантирована при использовании 
весов других производителей. 

 
 

.  
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8.2 Сообщения об ошибках  
 

Если Вы получили сообщение об ошибке, пожалуйста, делайте следующее: 
  

Для RTSLogTool  
 

Сообщение об ошибке Причина Что делать 

 

Сообщение появляется 
при запуске 
журналирования если 
выбран COM-порт, 
который не используется. 

Кликните на кнопке [Stop] 
для остановки 
журналирования. Выберите 
правильный COM-порт. 
Нажмите кнопку [Start] для 
возобновления 
журналирования.  

 

Сообщение появляется 
когда условия передачи 
данных с весов и условия 
приёма данных в 
программе не совпадают. 

Кликните на кнопке [Stop] 
для остановки журналиро-
вания. Установите 
соответствующие условия 
приёма и передачи данных 
на весах и в программе. 
Нажмите кнопку [Start] для 
возобновления 
журналирования. 

 

Сообщение появляется 
когда формат данных с 
весов и формат данных, 
установленный в 
программе, не совпадают. 

Кликните на кнопке [Stop] 
для остановки 
журналирования. Выберите 
формат данных, 
соответствующий формату, 
установленному на весах. 
Нажмите кнопку [Start] для 
возобновления 
журналирования. 

 

Сообщение появляется 
когда кнопка [Send] была 
нажата перед тем, как 
было запущено 
журналирование. 

Нажмите кнопку [Start] для 
начала журналирования. 
Затем нажмите кнопку [Send] 
для передачи команды на 
весы. 

 

Сообщение появляется 
когда установки, 
сделанные в программе, 
не могут быть сохранены. 

Удалите программу с 
компьютера и 
переустановите её заново. 
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Для RTSInputTool  
 

Сообщение об ошибке Причина Что делать 

 

Сообщение появляется при 
запуске журналирования если 
выбран COM-порт, который 
не используется. 

Выберите правильный 
COM-порт. Нажмите кнопку 
[External Display] или 
[Data input] для запуска 
соответствующей операции. 

 

Сообщение появляется когда 
условия передачи данных с 
весов и условия приёма 
данных в программе не 
совпадают. 

Установите 
соответствующие условия 
приёма и передачи данных 
на весах и в программе. 
Нажмите кнопку [External 
Display] или кнопку 
[Data input] для запуска 
соответствующей операции. 

 

Сообщение появляется при 
попытке запустить ещё один 
экземпляр инструмента RTS в 
добавок к уже запущенному.  

Не запускайте несколько 
экземпляров программы 
для одновременной работы. 

 

Сообщение появляется когда 
установки, сделанные в 
программе, не могут быть 
сохранены. 

Удалите программу с 
компьютера и 
переустановите её заново. 

 
 
 


